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1 Quick start
This chapter briefly introduces the use of our PLC programming software (PLC editor2) to write a
simple PLC control program and programming operations to help beginners get familiar with and
master the operation of our programming software as soon as possible. The following are the
development steps of PLC:
 Step 1: Start our PLC editor2 and enter the programming window.
 Step 2: Click "New" to pop up the "New Project" window, and set "PLC Series", "PLC Type"

and "Program Language".
 Step 3: Click "Program" in the "Project Management" area to start writing the ladder

diagram program.
 Step 4: Add instructions.
 Step 5: Save the program project (when the program has a specified save path, the

software will save the current program regularly).
 Step 6: Compile the program.
 Step 7: Establish a communication connection with PLC.
 Step 8: Download the program to the PLC.
 Step 9: Start the PLC (RUN state).

Start the software
After PLC editor 2 is correctly installed, click on PLC Editor2 in the Windows start menu to start the
PLC programming software and enter the main programming screen, which is shown in the
following figure:
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Create a project
After starting the programming environment, you first need to create a new project. Click "New" to
pop up the "New Program" window, you can select or create a new project:
 PLC series
 PLC model
 PLC language

To create a new project, please operate as shown in the figure below:
1 Move the mouse to the upper left corner of the program, and click the "File" menu.
2 After clicking the "File" menu, a new dialog box will pop up.

3 Select "PLC Series", "PLC Model" and "Program Language" through the drop-down box.
4 Click the "OK" button to create a new project.
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In this example, we select a 5V type PLC, using ladder diagram as the programming language, after
completing the steps of creating a new project, as shown in the following figure:

✎Note: For the operation of specific project management function, please refer to the relevant
chapters.

Add instructions
1 When a project is created, expand the directory tree of "Project Manager".
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2 After expanding "Project Manager", click "Instructions"→"Basic instructions", select the
specific instruction, such as "LD".

3 Press and hold the mouse, select "LD" and drag it to the right "Ladder Diagram (Write)""
input box, place it in the specified position, and release the left mouse button. Then you can input
the parameters and click "OK".
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✎ Note: In addition to the system default parameters, the input and output of some added
commands are empty, and the user needs to input parameters or component addresses. If you
want to add multiple instructions, repeat the above operation until all the instructions are added.

Compile program
After the program is written, it needs to be compiled and saved, which can be achieved by pressing
F4 on the keyboard or the Compile button in the program panel, as shown in the figure below.

If compiled successfully, it is shown as below.

If compilation fails, it is shown as below.

All errors will be displayed in the list box. You could select the specified error information,
double-click the specified information with the left mouse button, and the system will
automatically locate the error or warning position, which is convenient for you to debug the
program.
✎Note: The program could be downloaded to the PLC only when the compilation is successful or
there are no errors.

Communication test
The communication test is to improve the connection stability of the PLC and PC, and avoid the loss
of force cduring the transmission process.
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Preparation steps:
1 Open and run PLC Editor.
2 Click "Transfer Settings] of "Online" module above the program panel. As shown below:

3 The "Transfer settings" dialog box pops up, when the "Detailed settings" is not checked,
select the specified port, it is as shown in the figure below.

 USB connection: This download interface is only supported when using the PLC's USB port to
download programs or monitor devices. If a USB device is currently connected, the software
system defaults to the "PLC USB interface" button.

 Ethernet configuration: You could select the corresponding NIC and configure the IP address to
connect the PLC with Ethernet function, or search the devices in the LAN by the device search
function!

✎Note: Currently Ethernet is only supported by 5V-N series and 6V series.
 Serial port (COM) connection: Used when downloading programs or monitoring device using

the PLC's round head (8-pin head).
4 When the "Detailed Settings" option box is checked, the detailed settings window will

pop up as below. You could set data according to their needs.
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✎Note: The range of communication time check is 0 to 9999, and the number of repetitions is 0 to
5. Please do not exceed the limited range.

5 After completing the settings, you could click the "Communication Test" or "OK" to
perform a connection test.

6 If the test fails, the system will prompt as below.

7 The connection is successful as shown in the figure below:
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8 After successful communication, you could click “Device Info” to view the device
information.

Download program
Work to be done before downloading:

1 Open the compiler;
2 Create a new project and make the project compile successfully;
3 Install the corresponding PLC driver on the PC and connect the PLC and PC;
4 Complete the communication setting through the compiler.

Start downloading
After completing the preparations, move the mouse to the Online module, and click the "Write to
PLC" button to open the download setting window, as shown in the figure below:
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The online operation window is shown in the figure below:

Click "Param+Prog (P)" button, and the system will automatically select the preset option in the
message box. After the configuration is completed, click "Execute" . As shown below:
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After clicking "Execute", the system will automatically pop up a prompt window. Clicking "Yes"
means stop the PLC operation and start downloading the PLC program. Clicking "No" means that
the PLC will not be stopped, and the program will not be downloaded to the PLC. As shown below:

After clicking "Yes", the download and compile window will start to run. As shown below:

When the progress bar in the download window completes the progress, the system will promt
"Write to PLC(Complete)". As shown below:
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2 Overall introduction
After the software is started, enter the main interface, as shown in the figure below:

Toolbar
Most of the functions of the software can be found here, which are divided into PLC, view and help.

There are functions such as ladder diagram symbol, comment statement editing mode, compilation,
communication function and encryption tool in the PLC classification, which will be explained in
detail in the following chapters.
Functions such as each floating window and ladder diagram display scale can be enabled in the
view classification.
The help of the software can be viewed in the help category, and the software version number
information can be viewed through the about button of the category.

Project management
It is used to create new programs, operate program pages or program blocks, and configure PLC
parameters.
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Ladder editing
In short, it is the module for development. In this module, you could write programs, configure PLC
and other development. At the same time, you could add, delete, modify and check PLC through
this module.

Floating windows
It is used to display or realize a specific function, which will be explained in detail in the following
chapters.

Status bar: used to display the status of the PLC or program page.
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3 PLC function menu
Clipboard
Clipboard is a basic function of PLC Editor2 and has a very important function. This chapter will
explain the basic description of the clipboard.
The clipboard has five functions: "Cut", "Copy", "Paste", "Undo" and "Redo".

 Cut: After selecting the ladder diagram, you could use the "Ctrl+X" command or the right
mouse button to cut the selected data to the memory and switch to other places for use.

 Copy: After selecting the ladder diagram, you could use the "Ctrl+C" command or the right
mouse button to copy the specified data.

 Paste: After selecting the ladder diagram, you can use the "Ctrl+V" command or the right
mouse button to paste the specified data.

 Undo: Through "Ctrl+Z" or the right mouse button, the event operated by the user can be
rolled back. Only when the software is running continuously, and the cancellation cache will be
cleared if you exit.

 Redo: Through the "Ctrl+Y" or the right mouse button, you could return to the previous action
after canceling the event.

Ladder symbol
PLC Eidtor2 provides powerful and complete functions in the menu bar, which can greatly improve
programming efficiency, as shown in the following figure:

The following table is a detailed description of the ladder diagram.

Image Instruction Command function description Hot key

LD AND Input series normally open F5

OR Input parallel normally open SHIFT+F5

LDI ANI Input series normally close F6
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ORI Input parallel normally open SHIFT+F6

OUT Ladder diagram output coil F7

CJ/CALL and other
application instructions

Inpuyt application instructions F8

Ladder diagram input horizontal line F9

Ladder diagram input vertical line F11

Delete horizontal line in ladder diagram CTRL+F9

Delete vertical line in ladder diagram CTRL+F11

LDP ANP Input series rising edge pulse SHIFT+F7

LDF ANF Input series falling edge pulse SHIFT+F8

ORP Input parallel rising edge pulse CTRL+ALT+F7

ORF Input parallel falling edge pulse CTRL+ALT+F8

INV Invert the result of the operation CTRL+ALT+F11

Line segment input SHIFT+F9

Line segment deletion SHIFT+F11

MEP Rising edge pulsing of operation results ALT+F5

MEF Falling edge pulsing of operation results CTRL+ALT+F5
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Comment&statement
Editing comments or statement is mainly to comment the code in the project to better interpret
the project. As shown in the figure below, it enters the editing state.

Edit comment
Function: Comment on the device.
Prerequisite: devices are required on the ladder diagram.
Steps:

1 Click the "Comment" button, when the button color becomes darker, it will enter the
editing state.

2 After successfully entering the edit comment state, move the mouse to the code segment
specified by you, and double-click the target area with the left button, and the "Comment Edit”
window will pop up.

3 At this time, you could enter the specified comment in the column input box.
4 After editing the comment, click “Execute" to save it.

✎Note: The comment can be edited up to 128 characters, and the alias can be edited up to 8
characters.

Result:

Edit statement
Function: Annotate the ladder diagram block.
Steps:

1 Click the "Statement" button, when the button color becomes darker, it will enter the
editing state.

2 After successfully entering the edit statement state, move the mouse to the code
segment specified by you, and double-click the target area with the left button, and the "Statement
Edit" window will pop up.

3 At this time, you could enter the specified statement in the previous input box.
4 After editing the statement, click "Execute" to save it.
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✎Note: The statement line can edit up to 64 characters, and the statement can be downloaded to
the PLC when downloading the ladder diagram.

Result:

Program compilation
This chapter mainly introduces the program compilation function.
The program compilation menu has three functions, including compile, switch, and compile all, as
shown in the figure below:

Compile
Function: Refers to the form of converting the ladder diagram (program) of the current program
page into the instruction list (IL).
Steps: After compiling the ladder diagram, click compile or use the hot key F4.
Results:
 Compiling correctly will prompt that the compilation is successful.
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 Failure will prompt compilation failure. Locate the error and go to the information output
window. You could modify the ladder diagram according to the prompts.
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 Double coil inspection, manifested in the form of warning.

Switch
Function: refers to switching the current program page between the ladder diagram interface and
the instruction list (IL) interface.
Steps: Click the switch button on the program page interface.
Results:
 In the compiled program page, click to switch to the instruction list interface.

 In the uncompiled program page, the prompt "The current ladder diagram is not compiled. Do
you want to abandon the current ladder diagram?" Click "Yes" to abandon the editing ladder
diagram and convert it to the instruction list, click "No" not to switch.



PLC Editor2 software Help Manual V3.0

21 WECON technology Co., Ltd

Compile all
Function: Refers to converting the ladder diagram of all programs under the current project into
the form of instruction list (IL).
Steps: Click the compile all button or use the shortcut key “Ctrl+F4”.
Expected: As long as there is a compilation error, it will prompt compilation failure, and only when
all compilation succeeds will it prompt compilation success.
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Programmode

Monitor mode
Function:monitor the value of the devices on the ladder diagram, modify and debug the program.
Steps:
 Connect to the PLC and switch to monitoring mode.

 Right-click the menu, click "Debug" to modify the value of the device.
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 Click the ON, OFF, or ON/OFF inversion to set the device.

Monitor edit
PLC Editor2 provides the "Monitor edit" function. You could edit ladder program in the state of
monitoring it.
Steps:
 Connect to PLC and switch to "Monitor edit" mode.
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 Modify ladder diagram

 Compile the ladder diagram
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 After the compilation, download it to PLC.

✎Note: The firmware version requires above v2.000 version.

Online
The online menu provides rich functions. It is mainly divided into 10 parts: Transfer settings, Read
from PLC,Write to PLC, Checksum PLC, PLC Diagnosis, Remote operation, Device monitor, Module
monitoring, Clear PLC memory, and PLC clock set.

Transfer settings
Function: The main purpose is to improve the stability of the PLC and PC, and to avoid force
majeure problems during transmission that could lead to losses.
Steps:
 Open PLC Editor2, and click "Online" →"Transfer Settings". As shown below:

 "Transfer setting" dialog box will pop up. When using USB connection, select the specified port,
it is as shown in the figure below.
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When using Ethernet configuration, you could click "Devices research" to select the corresponding
NIC and configure the IP address to connect the PLC with Ethernet function,
✎Note:
Currently Ethernet configuration is only supported by 5V-N series and 6V series.

Click "Devices research" to pop up a search page, as shown below.
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Description: Clicking "Device search", it will automatically search for all PLC devices supporting
Ethernet in the network segment matching subnet mask, i.e., the host computor and PLC must be
in the same subnet to be recognized.
The subnet mask matches the network segment:
 If the IP of this machine is 192.168.56.237 and the subnet mask is 255.255.255.0, the PLC

within the 192.168.56 network segment will be searched.
 If the IP of this machine is 172.16.56.1 and the subnet mask is 255.255.0.0, the PLC in the

172.16 network segment will be searched.
 If the IP of this machine is 10.244.56.9 and the subnet mask is 255.0.0.0, then the PLC in the 10

network segment will be searched.
✎Note: The NIC used for the IP search function is the NIC selected by the user of the NIC selection
interface. Use: Click "Device search" to search for devices in the LAN, and the searched devices are
displayed on the interface. Selecting the corresponding line and clicking the "OK", the
corresponding IP information will be displayed in the IP address input box of the Ethernet
configuration. Please refer to the PLC programming manual for the specific PC network address
configuration.
When using the serial port to connect, select the specified port and check the "Detailed setting",
the detailed settings window will pop up as below.
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You could set the data according to their needs.
✎Note: The range of communication time check is 0 to 9999, and the number of repetitions is 0 to
5. Please do not exceed the limited range.
After completing the settings, you could click the "Communication Test" or "OK" to perform a
connection test.
If the test fails, the system will prompt as below.

Successful connection is shown as below.

After successful communication, you can click "Device Info" to view the device information.

Read from PLC
Function: Upload the data in the series PLC to the software through the communication line.
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Interface introduction:
 Para + program: Upload parameters and programs from the PLC to the software.
 Select all: Upload parameters, programs, comments, devices memory area settings and

electronic cam tables from the PLC to the software.
 Cancel all select: Cancel all selections.
 Execute: Start the upload operation.
 Stop: Stop the upload operation.
 Close: Exit the current window.
 Execute (upload): Upload the data of the lower computer to the software.
 Display/Hide: Display/hide the upload progress and other information, as shown in the figure

below:
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Steps:
Check the data items that need to be uploaded.
 If the selected data item is device memory, you could click "set" to set the title of the uploaded

device memory and the range of the device to be uploaded.

 If the selected data item is electronic cam table, you could click "set" to set the title of the
uploaded electronic cam table and the uploaded cam table.
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Click "Execute" to start uploading. At this time, the PLC needs to be in the stop state.

Keep communication and wait for the upload to complete.
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Write to PLC
Function: Download the ladder diagram program or other configuration to the PLC.

Interface introduction:
 Para + program: Download parameters and programs to the PLC.
 Select all: Download parameters, programs, comments, and devices memory area settings to

the PLC.
 Cancel all selections: Cancel all selections.
 Execute: start the download operation.
 Stop: stop the download operation.
 Close: Exit the current window.
 Calculated size: To calculate the number of steps of the ladder diagram, the size of the

downloaded file and the size of the comment, it needs to be connected to the PLC.
 Display/Hide: Display/hide the download progress and other information, show as below.
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Steps:
Check the data items that need to be downloaded.
 If the selected data item is device memory, you could click "set" to set the title of the uploaded

device memory and the range of the device to be downloaded.

The PLC needs to be in the stop state when downloading.
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Keep communication and wait for the download to complete.

Device monitor
Function: You can view and modify PLC register values and expansion module values online. Click
this item to pop up the interface as shown in the figure below.
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Interface description:
 Monitoring start: start the current monitoring, the value of the register can be viewed or

modified.
 End of monitoring: End the current monitoring, the value of the register cannot be viewed or

modified.
 Edit current value: After clicking, a dialog box named "Modify device value" will pop up, and

you could modify it.
 Close: Close the "Device Monitor” interface.
Steps:
Click "device monitor" to open the interface.

Click "monitoring start" button under the premise of communicating with the PLC.

The devices can be monitored by modifying the monitoring form, display, numerial and bit order .
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Switch device, search device and switch to monitor buffer memory.

Clear PLCmemory
Function: Clear the data of the PLC

Steps:
1 Before clearing the PLC memory, the PLC needs to be in the stop state.
2 Check the data object. If the PLC memory is checked, it includes but is not limited to data

devicess, bit devicess and special devicess.
3 Click "Execution" and wait for the PLC to clear the data.

PLC clock set
Function: Set the PLC clock. You could customize the internal time of the PLC to achieve the
purpose of accurate calculation.
Click “ PLC clock set" to open the clock setting interface.
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Explanation:
 Connection: Display the information of the currently PLC, read the parameters of this PLC, and

cannot be changed.
 Time and calendar area: you can easily select time information and match freely.
 Read PC time: The software will automatically read the current PC time without manual

calibration.
 Set time: After finishing the setting, click this button to save the current operation setting to

the PLC.
 Close: Do not save the current operating data, and exit to close this window.
Set time:

1 Please ensure that the PLC and PC communicate normally. If it fails to communicate
normally, please click "Transfer Settings" and put the PLC in the STOP state.

2 Click "PLC clock set" to open the time setting window.
3 Select the time required by the user in the time control panel or in the calendar panel.
4 The time interval of the year is 2000 to 2099; The interval of the month is January to

December; The time interval is from 0 o'clock to 23 o'clock; The partitions are from 0 minutes to 59
minutes; the second interval is from 0 seconds to 59 seconds.

5 You can also click [Get PC Time] to quickly match the current time (provided that the PC
time is accurate).

6 After completing the configuration, please click "Set time" to save, otherwise it will not
be saved. Successful setting is shown below.
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Remote operation
Function: Remote operation can quickly change the state of the PLC online and control the switch
of the PLC.

PLC diagnostics
Function: PLC diagnostics will monitor the errors generated by PLC in real time and reflect them in
the table. You could view the summary of the error, the cause and the treatment method through
this interface. If it is a problem with the ladder diagram, click Error Jump to jump to the location
where the error occurred.
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PLC checksum
Function: You could select the items that need to be verified by the PLC, as shown in the figure
below:
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Compare the difference between the program in the current PC software and the program in the
PLC, as shown in the figure below:

Double-click the list, and you could view the specific differences of the program, as shown in the
following figure:

Module monitor
Function: This function is used to monitor the BFM value of the module and modify the BFM data.
According to the description information corresponding to the BFM, the user can understand the
function of the BFM.
Interface description:
 Customization: Create a new module plan, and use the default data as the initial value of the

module BFM,. You could edit the plan content on this basis.
 Save: Create a new module plan, and use the current module monitoring data as the initial

value of the module's BFM, You could edit the plan content on this basis.
 Help: Open the instruction manual of the module where you could find the detailed

instructions for the module.
 Refresh: You can update the module information of the current PLC connection and refresh the

module information list.
 Working mode:
 Offline: Display all module models that can be connected to the current PLC model. You

could view the module BFM information when the module is not connected, or open the
module instruction file through the "Help" button;

 Online: Display the module information of the current PLC connection in the module
information list, and monitor/modify the BFM value of the module.

Steps:
Click "Module Monitor".
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Select the module you want to monitor to o view and modify the value.

Tool

PLC encryption tool
In the PLC Editor2, you could set a password for the PLC to maintain security. The PLC encryption
tool can be set to "upload password", "download password", and "clock password" respectively.
Explanation: The three types of passwords are independent (you must use separate decryption
when performing operations), and the set passwords can be the same or different which ensure
the safety and independence of PLC. As shown below:
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Precautions for setting a password:
 The setting steps of "upload password", "download password", and "clock password" are

exactly the same (only the type needs to be customized by the user).
 The length of the password can only be 8 characters, no more or less than.
 When setting a new password, the first time password and the second confirmation password

must be the same.
 When performing password operations, please ensure that the PLC and PC are in a normal

connection state, and the PLC must be in the NOT RUN state (close the switch of the PLC
panel).

 When the password is entered incorrectly for 5 times, the password is locked, and the
password can be entered again only when the PLC is restarted after power off.

Steps to set password:
 Connect the PLC and PC normally, and run the compiler at the same time;
 Turn off the RUN of the PLC;
 Click "PLC Encryption Tool" in the "Tool" panel;
 After opening a new window, if the "old password" input box cannot be entered, it means that

the PLC is not currently encrypted;
 Select the type of password that needs to be set, and click "Set". (The following PLC takes

uploading password as an example)

 Please follow the instructions to fill in the correct password.
 If the password length is not enough, there will be a prompt as follows:
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 If the secondary password is inconsistent, there will be a prompt as shown below:

 If the password is successfully set, there will be a prompt as shown below:

Clear password
If the PLC does not have a password, ignore this description. If the PLC has a password, please
enter the existing password if you need to clear the password. Please refer to the precautions for
input errors more than 5 times.

Steps to clear the password:
 Connect the PLC and PC normally, and run the compiler at the same time;
 Turn off the RUN of the PLC;
 Click "PLC Encryption Tool" in the "Tool" panel;
 Select the PLC password to be cleared in "Type", and click "Clear".



PLC Editor2 software Help Manual V3.0

44 WECON technology Co., Ltd

 After opening a new window, please enter the specified password in the "Please enter
password" area, and then click "Execute".

 If you input the wrong upload password, there will be a prompt as shown below:

 If the password is correct, there will be a prompt as shown below:

Project encryption tool
In the PLC Editor2, you could set a password for the project file to maintain security. As shown
below:
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Precautions for setting a password:
 The length of the password can only be 8 characters, no more or less than.
 When setting a new password, the first time password and the second confirmation password

must be the same.
 When the password is entered incorrectly for 5 times, the password is locked, and the

password can be entered again only when the project file is reopened.
Steps to set password:
 Click "Project encryption tool" in the "Tool" panel;
 After opening a new window, if the "old password" input box cannot be entered, it means that

the PLC is not currently encrypted;
 Select the password that needs to be entered, and click "Set".

 Please follow the instructions to fill in the correct password.
 If the password is not long enough, there will be a prompt as shown below:
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 If the secondary password is inconsistent, there will be a prompt as shown below:

 If the password is successfully set, there will be a prompt as shown below:

Clear password
If the project does not have a password, ignore this description. If the project has a password,
please enter the existing password if you need to clear the password. Please refer to the
precautions for input errors more than 5 times.
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Steps to clear the password:
 Click "PLC Encryption Tool" in the "Tool" panel, and click "Clear".
 After opening a new window, please enter the specified password in the "Please enter

password" area, and then click "Execute".
 If you input the wrong upload password, there will be a prompt as shown below:

 If the password is correct, there will be a prompt as shown below:

USB download
Function: Generate a bin file. You could use the file to download programs and other
configurations through the HMI screen.
Steps:
 Click on the U disk to download and open the interface.
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 Check the items that need to be downloaded, set the communication port parameters, and
select the location of the U disk.

 Click "Excute" to generate the bin file.
 Insert the U disk into the HMI screen to download.

Automatic backup
Function: Back up project files. You could view and retrieve historical versions through this
function.
Steps:
 Open the saved file, click compile, compile all, close the project, switch historical version or

switch program type after editing. You could see the historical version number increase by
clicking on the automatic backup window.
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 Click the remark information to add remarks to the historical version, and click "OK" save it.
 Check the version number, and click "switch to this version", it will close the current version

and load the historical version, as shown in the figure below:

Generate download file
Function: Generate a file for download only, and the file cannot be viewed and uploaded.
Steps:
 Compile all the program pages, click to generate the download file.
 Select the path and file name.
 Open the generated .swcp2 file and click download.
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Reset window layout
Function: Restore all floating windows in the program to the default position.
Steps: Click the reset window layout button in the view.
 Before reset:
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 After reset:

4 Program editing area
In the program editing area, the user can freely switch between the ladder diagram and the
instruction list. The ladder diagram interface provides editing operations. The instruction list
interface is only allowed to be viewed and cannot be modified.

Ladder work area
Insert a new row
 Select the position where you want to insert the row +1.
 Click on the keyboard "Shift] + Insert" to insert a new row, or move the mouse to any position

of the specified insertion row, right-click, select "Edit"→"Insert row above (shift+insert)".
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Insert the statement
Select the position where you want to insert the row.
 Method 1: Use the keyboard shortcut: Shift+Ctrl+Insert.

 Method 2: Keyboard shortcut "Ctrl+F7".

 Method 3: Right-click, select "Edit"→"Insert Statement".
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Delete row

Move the mouse to the row to be deleted; press and hold the left mouse button to select and
move the row to be deleted (multiple rows are possible), the selected area will change color, and
then click "Delete" on the keyboard.

You could also select the row to be deleted, right-click to select "edit"→"delete row".
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Delete the statement
Same as row deletion.
Insert column
 Select the position where you want to insert the column.
 Click the keyboard "Ctrl+ Insert" to insert, or move the mouse to any position of the specified

insertion row, and right-click, to select "Edit"→"Insert column to the left".

Delete column
 Select the position of the column to be deleted.
 Press "Ctrl+Delete" on the keyboard to delete the column, or move the mouse to any position

of the specified inserted row, right-click, and directly select "Delete", or select "Edit"→"Delete
row".
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Before deleting:

After deleting:

Copy and paste
The copy and paste function could save time and reduce the time on repeated operations.
Steps
 Move the mouse to the ladder editing area.
 Select the specified cell or drag the mouse to select an area.

 Use the "Copy" button of "Clipboard" in the "PLC Menu", or use the right mouse button to
"Copy", or use the keyboard "Ctrl+C".
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 After completing the third operation, copy the specified area to the clipboard.
 Move the mouse to the designated position to be pasted, click the "Paste" button on the

"Clipboard", or use the "Paste". Move the mouse to the designated position to be pasted, click
the "Paste" button on the "Clipboard", or use the "Paste" function of the right mouse button,
or use the keyboard "Ctrl+V" to copy the specified data Copy to the specified location.
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Delete and modify ladder diagram devices
Steps:
 The ladder diagram can be modified only in the "Edit mode" state.

 Use the mouse to select the components that needs to be modified, and double-click the left
button or press the "Enter" key on the keyboard.

 After performing step 2, the output instruction dialog box will pop up.
 Enter the instruction corresponding to the selected component into the dialog box.
 Click "Execute" to save the modification.
✎Note:
 The modified instruction must be able to pass the correct instruction verification before it can

be saved.
 The contact element that occupies a cell (normally open, normally closed, rising edge, falling

edge, reverse, stepping) cannot modify each other with the comparison contact.
 All contact components cannot be modified mutually with coils or application instructions.
Delete ladder diagram components
Steps:
 The ladder diagram can be deleted only in the "Edit mode" state.
 Use the mouse to select the component grid that needs to be deleted, left-click, and the

selected part will be locked with a blue frame, and then you could press "Delete" on the
keyboard to delete it.

 Batch delete: Move the mouse to the specified delete area, hold down the left mouse button
and drag the mouse, and select cells in batches (cells will turn blue). After completing the
selection, you could press "Delete" on the keyboard to delete it.

 Delete horizontal and vertical lines: In this special ladder diagram, you could perform step 2 or
3 to select the target first, and then click the "CF9" icon or "CF11" in the "Ladder symbol"
function of the menu bar to execute the corresponding deletion.

Enter ladder diagram instructions
There are 5 ways to input ladder diagram instructions:

1 Direct input
2 Input through instruction set
3 Double-click cell
4 Instruction help
5 Ladder symbol/Shortcut

 Direct input method
 Move the mouse and left-click the specified cell.
 Directly use the keyboard to input the specified instruction, the system will automatically

pop up the ladder diagram input box.
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 Enter the complete instructions and parameters in the dialog box.
 Click "Execute" or the "Enter" button on the keyboard.
 The system verifies the correctness of the input, and generates the graphic element

represented by the instruction after the verification is correct.
 If the instruction is wrong, the instruction help interface will pop up.

 Input through instruction set
 Move the mouse to the [Project Management] interface on the left side of the window.
 Expand "Instruction Set" and open the instruction tree you need
 Select the instruction you need, and left-click and hold, drag it to the "ladder diagram
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writing area", and place it in the specified area.
 After completing step above, a "ladder input " will pop up, then input the correct operand.
 Click "Execute" or "Enter" on the keyboard.

 Double-click the cell
 Move the mouse to the specified area and double-click the left button.
 "Ladder input" pops up, enter the correct command in the input box.
 Click "Execute" or the keyboard "Enter".
 If the instruction is wrong, the instruction help interface will pop up.

 Instruction help
 Move the mouse to the designated area and double-click the left button to pop up

“Ladder input”.
 Click “Help” to pop up “Instruction Help”。
 After selecting the instruction that needs to be entered, click the "Detail" button to pop up

the "Instruction Wizard".
 The instruction guide interface selects the correct operand according to different

instructions.
 After selecting the specified instruction, click "Execute" to save the data and complete the

instruction input.
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Ladder symbol/shortcut
The ladder diagram symbol is located in the PLC menu, as shown in the figure below:

After selecting the cell, click "Ladder Symbol" in the menu, and enter the operand in the pop-up
ladder diagram input box to complete the instruction input. If it is an application instruction, after

clicking on the panel, you must input the complete application instruction and its operands in

the ladder diagram input box to complete the input instruction. You can also use the shortcut
corresponding to the command (see the shortcut key list) to input, and the operation method is the
same as the "ladder symbol".
After the instruction input is completed, click the "Execute" button in the ladder diagram input box
and it will be displayed in the ladder diagram editing area.
✎Note:
 Some instructions can only be input in the instruction list (IL) editor, but not in the ladder

diagram, such as MPS, MPP, etc. When these instructions are directly input in the ladder
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diagram, no components will be generated.
 Since coils and application instructions represent the end of one line of the ladder diagram

program, no other components can be input after these components.
 Since the vertical line occupies the space of two lines, when inputting the vertical line, if the

corresponding position in the next line is just the middle part of other components, the vertical
line cannot be input.

 The maximum number of input columns in the ladder diagram is 13 columns.

Instruction list work area
Instruction list editor
In the PLC Editor, the program not only provides a ladder diagram editor, but also provides an
instruction list interface. The instruction list interface is not editable and only allowed to be viewed.
As shown below:

 Step number: The step number indicates the position of the instruction in the program, which
can be used to quickly locate the program and improve the readability of the program.

 Ladder diagram-instruction list switching: If there is an error in the program logic, it cannot be
switched.

Shortcut menu
In the program editing area, click the right mouse button to pop up frequently used function
buttons, which can greatly improve the developer's development efficiency.
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Undo: Undo the current operation and roll back the previous step.
Redo: Roll back the undo operation.
Cut: Cut the selected content in the ladder diagram and put it on the clipboard.
Copy: Copy the selected content in the ladder diagram and put it on the clipboard.
Paste: Paste the data in the clipboard at the selected position in the ladder diagram. When there is
no data in the clipboard, paste is not available.
Delete: Delete the selected content in ladder diagram.
Compile: Compile the current program page.
Editing options:
 Insert row: Insert an blank row in the current selected row in the ladder diagram.
 Insert statement: Insert a blank staement row in the current selected row in the ladder

diagram.
 Delete row: Delete the currently selected row in the ladder diagram.
 Insert column to the left: In the ladder diagram, a blank node is added to the selected

instruction, and other instructions move one space to the right.
 Delete column: In the ladder diagram, delete the currently selected instruction, and other

instructions move one space to the left.
Search:
 Device search: open the search/replace window, the default is the device search page, if the

selected instruction in the ladder diagram contains a device, the "search device" defaults to
the selected instruction's device, and it will be empty if there is none.

 Instruction search: Open the search/replace window, the default is the command search page,
if the command is selected in the ladder diagram, the "search command" defaults to the
selected command, and it is empty if there is no command.

 String search: Open the search/replace window, the default is the string search page, if a string
is selected in the ladder diagram, the "search string" defaults to the selected string, and it is
empty if there is no string.

View:
 Comment display: In the ladder diagram, the comment of the device is displayed.
 Alias display: In the ladder diagram, display the alias of the device.
Debugging:
 Modify the current value: In the monitor mode (write mode is not available), open the device

write dialog box. Modify the value of the device of the currently selected instruction.

5 Project management
Program
MIAN is the default program page name for a new project. There can be multiple program pages in
a project. Double-click the program page to open the ladder diagram editing area in the user area,
and you could edit the program.
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New program page: select scan/event/subroutine/interrupt, right click"scan"→"new", you could
open the new program window, as shown in the figure below:
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Program page operations: Right-click the program page with the mouse to perform corresponding
operations.

Delete: Delete the program page. Rename: Rename the program page.
Program encryption: Encrypt and decrypt the program page.
 Encryption: select the program page to be encrypted and set the encryption password, After

the encryption is executed, the program page is in the "encrypted" state, and the content of
the program page is not displayed.
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 Cancel encryption: After entering the correct password, cancel the encryption of the program
page.

 Modify password: After entering the original program page password, set a new program page
password.
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 Display encrypted content: Display the encrypted program page content. This function is only
used to temporarily display the content of the program page without canceling the encryption
status of the program page, which is convenient for editing the encrypted program page.
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Set: Right-click it, and you could view the author, date of creation, and remarks on the program
page.

 Configuration: The time and interrupt program page can click the configuration button to set
the trigger condition.
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Move up:Move the program page up, used to adjust the execution order of the program page.

Move down: Move the program page down to adjust the execution order of the program page.
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Device comment
Device comment module: A .wcp2 file has one and only one module named "COMMENT" in
"device comment". Double-click "COMMENT" and shown as below.

Interface label description:
 Enter device name: Input the correct device name and press "Enter" to confirm, the comment

list will locate the input device and select it.
 The comment list is divided into 3 columns: device name, device comment, and device alias.

Click the comment list, and select the device row, and double-click the device comment or alias
to pop up an edit box for editing. The device comment value allows 128 characters, and the
device alias only allows input of 8 characters.

 Device interval selection: Click to select the device interval and change the device displayed in
the comment list. The blue device section indicates that the section is selected. The devices
interval is as shown in the figure below:
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Interface button description:
 Display commented devices: The comment list displays all devices with comments or aliases.
 Import EXCEL: select the *.xls file to be imported, and import all the correct device comments

and aliases in the *.xls file into the software (supports *.csv file import).
 Export EXCEL: Export and save all the devices information of edit devices comments or aliases

as *.xls files to local disk.

Parameter
You could set the latch range of the PLC devices and the COM port communications according to
your needs. Click the "×" symbol in the upper right corner to close the dialog box and change
without saving.
Double-click the "PLC Parameters" node and the interface is shown as below.
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Interface button description:
 Check: Check the configuration of the current settings, respectively check the "device latch",

"COM1 " and "COM2". If the check fails, click the "OK" button to report an error.
 Reset: Click this button to restore the default settings.
 OK: Complete the correct PLC parameter change and set it.
 Cancel: Cancel the PLC parameter setting and keep the parameter setting before the change.
Device latch
The address range of various types of registers including PLC is set in the devices. You could set
parameters in the white squares in the picture table, but not the gray ones (cannot be modified).
By modifying the data at the beginning and end of the latch, the latch range of the register can be
modified, and the modified data range must be within the latch range.

COM1 settings
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 Whether to set: Whether to enable the COM1 port configuration.
 Baud rate: Select the data transmission rate.
 Data bit: Select the data length.
 Stop bit: Select the number of stop bits.
 Parity: Select the number of parity.
 Station No.: Set the station number, ranging from 1 to 47.
COM2 settings

Whether to set: whether to enable the COM1 port configuration.
 Communication settings
 Baud rate: Select the data transmission rate.
 Data bit: Select the data length.
 Stop bit: Select the number of stop bits.
 Parity: Select the check digit.
 Timeout: Set the timeout time, ranging from 0 to 32767.
 Sending interval: Set the sending interval, ranging from 0 to 32767.
 Protocol: Select the communication protocol.

 Protocol related
 Station No.: Set the station number. According to different protocols, the station number

setting range is different.
 Whether to enable the start character: used to customize the protocol.
 Starter: set the end character for custom protocol.
 Whether to enable terminator: used to customize the protocol.
 Terminator: Set the terminator to customize the agreement.
 Timeout between characters: used to customize the protocol.
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Ethernet settings

✎Note: Currently Ethernet configuration is only supported by 5V-N series and 6V series.
 Communication settings
 Whether to set: Whether to enable communication configuration of Ethernet setttings.
 Whether to enable PLC automatic configuration IP (DHCP) function: automatic

configuration IP (DHCP) function. (only supported by 6V series currently)
 IP address: Configure the IP address of PLC
 Subnet mask: Configure the subnet mask of PLC
 Default gateway: Configure the default gateway of PLC

 Protocol related
 Whether to set: Whether to enable the protocol configuration of Ethernet settings.
 Maximum number of connections supported by modbusTCP server: Number of

simultaneous connections available for other modbusTCP clients. (only supported by 5V-N
series currently)

Basic information settings
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It is used to configure some basic information.
 Whether to set: Whether to enable the basic information settings.
 PLC name: Used to set the name of PLC. The maximum number of characters allowed to be

entered is 32; the range of illegal characters not allowed to be entered:
/%$@&=~`^<> :{}[],; *. \'"|

✎Note:
 The first one is a space, and a space is also an illegal character.
 Currently, only PLCs with Ethernet function (5V-N series and 6V series) are supported.

Device memory
It is used to set the data of PLC data block when PLC is downloaded, and the data of the read PLC
data block is displayed when PLC is uploaded.
New devices memory: Right-click and select the "device memory" → "New" to create a new device
memory file (any character in the file name, up to 64 characters in length, and only one can be
downloaded at a time). The interface is as follows:

Interface label description:
 Please enter: Enter the device to be searched, and press "Enter" to locate the device to be

searched.
 Device list: Divided into 10 intervals: C, D, HSC, LC, M, R, S, T, V, Z.
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 Device value display area: Currently editing operations are prohibited.

 Cell format: 7 data formats: binary, decimal, hexadecimal, octal, real number, character string,
ASCII code. One format and one color:
 Binary: red
 Octal : pink
 Decimal: blue
 Hexadecimal: brown
 Real number: orange
 Character string: cyan
 ASCII code: green

 The data can be expressed in size: 16 bits and 32 bits.
 The data size that each format can represent when the length is 16 bits:
 Binary: 0000000000000000 to 1111111111111111;
 Octal: 0 to 1777777;
 Decimal: -32768 to 32767;
 Hexadecimal: 0 to FFFF;
 String: the size of 2 characters in length;
 ASCII: 2 ASCII code values.

 The data size that each format can represent when the length is 32 bits:
 Binary: 00000000 00000000 00000000 00000000 to 11111111 11111111 11111111

11111111;
 Octal: 0 to 37777777777;
 Decimal: -2147483648 to 2147483647;
 Hexadecimal: 0 to FFFF FFFF FFFF FFFF;
 String: the size of the length of 4 strings;
 ASCII: 4 ASCII code values;
 Real number: ±1.175495E-38 to ±3.402823E+38.
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Electronic cam
In the project management window, right-click “electronic cam table” to create a new electronic
cam table (ECAM table).

Open the ECAM interface and set the data.

Click the parameter setting to set the parameters, such as the starting device, which indicates the
starting position of the download time.
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The ECAM table information written by other programs can be imported into the ECAM table
through import and export. You could download the ECAM to the PLC.

Instructions
Available instructions are as follows: all instructions; basic instructions; step ladder instruction;
program flow; transfer and compare; Arithmetic; cycle and shift; data processing; high-speed
processing; common instruction; peripheral device IO; peripheral device SER; floating; contact
compare; high-speed pulse output; clock calculation; floating contact comparison; data table; data
block; communication instruction; electronic CAM; other instructions; string control; Ethernet.
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PLCLINK table
New table: After create a new table, you could view "PLCLINK" in project manager window.
Right-click it to create a PLCLINK table.

Starting address settings: You can select D or R device as the area for storing PLCLINK table
contents, and edit the starting device address, which will occupy 22+5*n devices starting from this
device. This occupancy information reflects the tabular operation in the list of device used.
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New command: Click "New command" to generate a PLCLINK command.

Delete: Select the PLCLINK command to be deleted to delete the command.
Modify station NO. : You select the station number in the drop-list. The station numbers of station
No.1 and station number No.2 cannot be the same. Range: 1 to 31.
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Modify device name: Select device name in the drop-list, note that the soft component type of
station number and station number (2) need to be the same.
Modify device address: Edit the start address edit box and enter the value within the range of the
device. Modify the number of device: Edit the number of device edit box, and enter the number of
device.The number of double-word device ranges from 1 to 64. Device ranges from 1 to 128, and
bit device ranges from 1 to 1024.
Modify instruction enable status: Click "Station No. Enable" to edit the parameters of the two
stations of this instruction. The master station is always enabled and cannot be modified.
For example:
 Click "New Command" to create a PLCLINK command.
 Station NO.1 is selected as 2, station number NO.2 is selected as 3.
 Click 'Station NO. Enable". If station number NO.1 is checked to enable, but station NO.2 is not

checked to enable, the command enable is invalid. Only when both station numbers are
checked to enable, the command enable is valid.

PLCLINK operation
 Check: Check whether the data of PLCLINK is legal.
 Save: Enabled under the condition that the program is consistent in monitoring mode, and it

will compare once automatically when entering.
 Check Slave: Send command to PLC to check slave information.
 Monitor Read: Get PLCLINK table information from PLC.
 Monitor Write: Write PLCLINK table to PLC
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Ethernet
Interface: Click "Project manager"→ "Extended function", and right-click "Ethernet" to open the
"New-Ethernet configuration" window.

The introduction of parameters:
 Whether to enable:Whether to enable the Ethernet configuration
 Socket ID: The number of socket supports a total of 6 ranging from K0 to K5. The socket ID is

used to specify the link. Each ID is used for one link and cannot be defined repeatedly.
 Communication protocol: TCP protocol and UDP protocol are supported.
 Operating mode: For TCP, you could select client and server. For UDP, this does not work.
 Local port:
 For TCP client mode, the local port will be automatically allocated by PLC without setting.
 For TCP server mode, the local port could be set within the range of 1 to 65535. Port 502 is

used by internal modbusTCP and cannot be set.
 For UDP mode, the local port could be set within the range of 1 to 65535. Port 1092 is

used by scanning protocol and cannot be set.
 Target ID: Valid in TCP client mode or UDP mode, specifying the peer device IP to be linked.
 Target port: Valid in TCP client mode or UDP mode, specifying the peer device port number to

be linked.
 Receive timeout: After PLC sending data, if the response of the peer device exceeds this

timeout, the network is considered abnormal and the error flag bit is set.
 TCP keep-alive mechanism: When TCP protocol is used for communication, If the

communication line is idle in most cases and only a small amount of data is sent and received,
but the link needs to be kept open, or disconnected in time in case of a drop, crash or forced
termination of the process at the communication end, you can use the keep-alive mechanism
for communication.

Description: Ethernet socket configuration, with Ethernet SOC series instructions, can achieve
ModbusTCP client, TCP free protocol, UDP free protocol.
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Use: Configuring the corresponding properties to achieve the corresponding functions, and
download to the PLC through the download interface and the program to. For specific use rules and
configuration methods, please refer to the PLC programming manual.

BD board configuration
Function entry: In "Project Management" interface, expand "Extended Function", and double-click
"BD Board Configuration".

Introduction of function interface
The main interface is divided into two parts. One is the current configuration information list, and
the other is device list for users to choose configuration.
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1 Device list: It includes "PLC Host" and "BD Board". You can add device to the configuration list
on the left by double-clicking the contents under the two nodes.

"PLC Host" contains all the points existing in the actual device of PLC model set in the current
project. Try to ensure that host points in the configuration list are consistent with the points
actually connected to PLC, otherwise it may occur that the host computer is configured with two
BD boards, but the actually connected PLC has only one BD board slot, resulting in the situation
that the configuration of BD2 will not take effect.
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"BD Board" contains all BD board models that can be supported by 5V series PLC at present.
2 Configuration list: Display the information of PLC host and BD board currently configured.

 Slot number: 0 is the host by default, 1 is BD1, and 2 is BD2.
 Configure device name: Displays the device name.
 Device description: Displays a brief description of the device.
 Device occupancy: Displays the device occupancy of the configuration device.
 Actual installation type: In monitoring mode, display the BD board model actually

connected by PLC.
 Device version number: In monitoring mode, display the BD board version number actually

connected by PLC.
3 Introduction to configuration operations
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 Add BD board Configuration: Add by double-clicking BD board in the device list on the
right.

 Modify BD board configuration: Open the BD board configuration window by
right-clicking on the menu or double-clicking on the BD Board in the configuration list.

 Move up/down: The positions of the BD boards configuration on slot 1 and slot 2 can be
swapped.

 Delete BD board configuration: Delete BD board configuration.

Introduction of BD board configuration interface
1 Module configuration: Used to configure the general configuration of BD board, applicable to
all channels.

2 BD board channel configuration: The enable status and parameter settings of each channel of
BD board can be configured.
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3 I/O mapping: The channel value of the BD board is displayed by the device through mapping.

4 Device information: Display device information of BD board.

5 Reset: Initialize the configuration data of BD board, and the parameters are the same as when
the BD board is added.
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Other functions
1 Device information: You can view the BD board model and corresponding version number
currently connected by PLC.

2 PLC calibration: Check the configuration of BD board and PLC.
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3 BD board monitoring

4 U disk download: BD board configuration function supports U disk download, and the data will
be packaged together with the program node.
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✎Note:
1 The minimum software version number of the slave computer that supports the BD board
configuration function: V2.051.

2 The BD board model and slot position of PLC currently connected to the host computer should
be consistent with the configuration list of BD board of the host computer.
3 Ensure that host points in the configuration list is consistent with the number of points
actually connected to PLC, otherwise it may occur that the host computer is configured with two
BD boards, but the actually connected PLC has only one BD board slot.
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6 Output window
Information output
Information output window: Provide users with the results after the software performs operations
including the execution result information of the three operations of compiling, communication,
and switch.

If there is an error in the program, the error will be listed in the "Information output" module at the
bottom of the ladder diagram. Select the specified error item, and double-click to locate the error
position of the ladder diagram.

Search&Replace
Search and replace function: Similar to the search and replace function of OFFICE, it can locate the
data block specified by the user in a large amount of data, or perform batch addition, deletion,
modification, and check, which can greatly improve efficiency.
How to use: Open the main program, after creating a new project, click “Ctrl+F” on the keyboard to
pop up the search and replace interface, as shown in the following figure:
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Buttons are divided into 4 categories: devices, instruction, string, and result, as shown in the figure
above; clicking any one will switch to the corresponding operation interface.

7 Modify device value
Modify device value: modify the PLC internal register and coil value; modify the expansion device
register value. As shown below:

PLC internal devices:
 Devices:
 "Devices" are registers and coils (such as C0, M1, etc.) whose values need to be modified

within the range of PLC.
 "Data type" includes Word (single word) , Bit (binary 0 or 1), double Word, float (single
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precision floating point number).
 "Value" is the specific value to be modified (corresponding to the number in the range of

"Data Type"), such as -120.
 The data format can be decimal (single word: -32768 to 32767; double word: -2147483648

to 2147483647) or hexadecimal (single word: 0 to FFFF; double word: 0 to FFFFFFFF).
 Click "Set" to write the set value within the correct range to the selected device.

 Execution result: Record the successfully modified "device", "data type" and "set value" in the
form of a list.

 Record list:
 Click any one in the list, and click "Delete" to delete it.
 Click "Clear List" to clear the record list.
 Select any one in the record list and click "Response to Input Field" to reflect the items in

"device" .
PLC external expansion module:
 "Module start" is the extension module number (such as module 0).
 "Address" is the internal writable address of the expansion module, and the address type can

be decimal or hexadecimal.
 "Data type" includes Word (single word), Double Word, Float (single precision floating point

number) .
 "Value" is the specific value to be modified (corresponding to the number in the "data type"

range), such as -120. The type can be decimal or hexadecimal.
 The data can be decimal (single word: -32768 to 32767; double word: -2147483648 to

2147483647) or hexadecimal (single word: 0 to FFFF; double word: 0 to FFFFFFFF).
 Click "Set" to write the set value within the correct range to the selected device.
✎Note:
 Modification of the device value must be executed in the case of communication with the PLC.
 The device must be within the available range of the corresponding PLC model.
 The input value must be within the allowable range.
 Decimal: single word (-32768 to 32767), double word (-2147483648 to 2147483647)
 Hexadecimal: single word (0 to FFFF); double word (0to FFFFFFFF)
 Floating: ±1.175495E-38 to 3.402823E+38
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8 Print ladder diagram
The print function is divided into: print, print preview, and print settings.
Preconditions for printing
 Open the project file (not the project file generated by the "Generate Download File" function).
 The program has all been compiled.
 The program is in edit mode.
Only when the above three conditions are met, the print button can be clicked.

Printing preview
Before printing, you could preview the print on the screen. Click the "File"→"Print"→"Print
Preview" to open the print preview window as shown in the figure below:
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Print preview interface

Print
When you need to print, please click the print button, and a standard print dialog box will pop up.
You could set the print options here. After setting, you could click "OK" to output the current
program to the printer.
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Printer settings
Set print information. As shown below:

9 Status Bar
Indication: language, uppercase and lowercase status, digital keyboard lock status, rewrite/insert
status, communication port, project model, current program steps/total program steps and other
status information.

 Language: The language type displayed by the software. Highlighted means enabled.
 Case state: English input state.
 Numeric keypad lock:Whether the numeric keypad is available.
 Rewrite/insert state: ladder diagram editing mode.
 Communication port: communication COM port. Click it to pop up the communication setting

window.
 Project type: Display the PLC model of the current project.
 Current program steps/total program steps: Program editing page, program steps of the

currently selected instruction/total program steps.
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10 Device usage list
The device usage list mainly displays the specified type of device. You could check the usage, and
the corresponding comment and alias of the device.

Instructions for using the list of devices:
 Device selection drop-down box: select the drop-down box option, search for and display the

usage of the corresponding type of Device (starting from serial number 0).

 Start devices drop-down box: You could enter the full name or serial number of the start
devices, press the Enter key or press the "search" button to search and display the usage of this
type of devices (starting from the initial serial number). Record the search record in the
drop-down box. After selecting the record, you could perform the search again.

 Search button: Perform a search operation. When the starting device is empty, it will prompt to
input a device.
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 Search range: Specify the search range of the device.
 Current program page: Search only for the currently active program page.
 Current program type: Only for all program pages of the same type in the currently

activated program page.
 Whole project: for all program pages of the current project. (The program page types are

divided into: scan, event, subroutine, interrupt)

 Expand and close the sub-items of the device usage list.

 The sub-items of the devices usage list includes instruction, step number, type and other
information of the devices in the program. Double-click the content of the sub-item to locate
the corresponding position in the program.

 Device comment and alias column: (the background color is white) displays the comment or
alias of the device.
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Display options:
 All devices: After selecting, search all devices of this type.

 Used devices: After selecting, search for the used devices of this type according to the contact
and coil options.
 Neither the contact nor the coil is selected, and all the devicess of this type that have been

used in the program are displayed.
 Select the contact (coil) to display the type of devices as the contact (coil) in the program.
 Select both contacts and coils, and display the type of devices that are used as contacts

and coils in the program.

 Unused devices: After selecting, display all the devicess of this type that are not used in the
program.

11 Shortcut keys list
Universal shortcut keys
The universal shortcut keys are as follows:

Hot key
Corresponding menu

(function name)
Summary

Ctrl + N New Project New Project
Ctrl + O Open the project Open an existing project
Ctrl + S Save the project Save the project
Ctrl + X Cut Cut selected data and range
Ctrl + C Copy Copy selected data and range
Ctrl + V Paste Cut/paste the copied data at the cursor position
Ctrl + Z Revoke Revoke the previous operation
Ctrl + Y Restore Resume the operation canceled by “Undo”
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Ctrl + F Search device Search device

Ctrl + F1
Display/hide menu

toolbar
Display/hide menu toolbar

F3 Start Monitoring
Currently, start to monitor the window that is the target of
the operation

Ctrl + F3 Monitoring stop
Currently, stop monitoring the window that is the target of
operation

F4 Compile Compile (switch) the program page currently being edited
Ctrl+F4 Compile all Compile (switch) all program pages in the current project
Alt+F4 Exit the software Exit the software

Shortcut keys for ladder editor
The shortcut keys that can be used in the ladder diagram editor are as follows:

Shortcut key
Corresponding menu

(function name)
Summary

F5 Normally open contact
Write normally open contact to the cursor
position

Shift + F5 Normally open contact OR
Write normally open contact OR to the
cursor position

F6 Normally closed contact
Write normally closed contact to the cursor
position

Shift + F6 Normally closed contact OR
Write normally closed contact OR to the
cursor position

F7 Coil Write coil to the cursor position

F8 Application instructions
Write application instructions to the cursor
position

F9 Horizontal line input Write horizontal line to cursor position
F11 Vertical line input Write the vertical line to the cursor position

Ctrl + F9 Delete horizontal line
Delete the horizontal line at the cursor
position

Ctrl + F11 Delete vertical line Delete the vertical line at the cursor position

Shift + F7 Rising edge pulse
Write the rising edge pulse to the cursor
position

Shift + F8 Falling edge pulse
Write the falling edge pulse to the cursor
position

Ctrl + Alt + F7 Parallel rising edge pulse
Write the parallel rising edge pulse to the
cursor position

Ctrl + Alt + F8 Parallel falling edge pulse
Write the parallel falling edge pulse to the
cursor position

Ctrl + Alt + F11
Invert the result of the
operation

Write the result of the calculation to the
cursor position

Ctrl + Shift + Insert
Insert statement between
lines

Insert the declaration line at the cursor
position

Shift + Insert Insert program row Insert the row at the cursor position
Shift + Delete Delete row Delete the row at the cursor position
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Ctrl + Insert Insert column Insert the column at cursor position
Ctrl + Delete Delete column Delete the column at the cursor position

Ctrl + →
Enter/delete horizontal line
in the right direction

Enter/delete horizontal line from the cursor
position to the right

Ctrl + ←
Horizontal line input/delete
in the left direction

Enter/delete horizontal line from the cursor
position to the left

Ctrl + ↓
Enter/delete the vertical
line in the downward
direction

Enter/delete the vertical line from the cursor
position down

Ctrl + ↑
Upward vertical line
input/delete

Enter/delete the vertical line up from the
cursor position

Ctrl + /
Normally open/normally
closed contact switching

Switch between normally open contact and
normally closed contact

Ctrl + G Jump
Display jump to the instruction position
corresponding to the specified number of
steps

Ctrl + F5 Comment display
Display device comments and label
comments

Ctrl + F7 Statement display Display statement
F1 Open instruction help Display instruction help
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